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Welcome to My CallPilot

My CallPilot from Nortel Networks is a web-based business 
communications system that offers exceptional flexibility for managing 
your messaging needs. 

You can work with My CallPilot from any computer that has Internet 
access and a web browser configured for My CallPilot. Here are some of 
the many ways you can use My CallPilot:

! View useful information about your mailbox.
! Receive, forward, reply to, and send voice messages, faxes, 

and e-mails.
! Change the setup of your mailbox features. 
! Change your CallPilot password.
! Create personal distribution lists.
! Set up remote notification to a telephone or pager.
! Set up text message notification for a wireless e-mail device. 

See Appendix A for details.

Some features mentioned in this guide are options. For details, refer to the 
Feature availability topic in the CallPilot Player online Help, or ask your 
administrator. 
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Getting started

About this guide
This user guide describes how to use the web-based resources of My CallPilot. The 
instructions and screen images shown in this guide provide general information for 
using My CallPilot through a web client. Specific details may vary depending on your 
computer’s operating system, and the features available for your CallPilot mailbox. 

For further assistance, refer to the My CallPilot online Help.

What you need
You can access My CallPilot from any computer with Internet access and a web-
browser configured for My CallPilot. Before you start to use My CallPilot, ensure that the 
computer you are using is set up according to the following requirements:

Windows-based hardware and software
! Windows 98 SE, Windows 2000 Professional, or Windows XP 
! Internet Explorer 5.x and 6.x, or Netscape 6.2x and later

! Sound card and speakers for playing voice messages on your computer
! A microphone connected to your computer, or a telephone situated near your 

computer, for recording voice messages
Macintosh-based hardware and software
! PowerPC G3 processor or newer (PowerPC G4 preferred)
! Mac OS version 9.0 or 9.1(preferred)

Note: The Mac My CallPilot Web Client software is not designed for compatibility with 
Mac OS X. Although this version of the CallPilot application may run in 'OS 9 
Compatibility mode', it may crash or behave erratically.

! Internet Explorer 5.1 (or newer) or Netscape Communicator 6.2 (or newer)
! QuickTime version 4.0 or newer

! AppleScript version 1.3 or newer
! TCP/IP network connection of at least 56 Kbit/s
! MacOS-supported sound output device (speakers)

! MacOS-supported sound input device (microphones)
Note: The type of microphone to use depends on the type of Macintosh the user has, 
and a microphone designed for a Windows-based PC will often not work. Some older 
PowerPC Macs require a PlainTalk microphone, or similar. The system administrator 
should verify that the user has a working microphone and speaker setup before 
installing CallPilot.

Peripheral hardware and software
! Video display and monitor with 8-bit (256-color) 800 x 600 capability (1024 x 768 

16-bit color preferred)

! Nortel Fax Driver and CallPilot Desktop Messaging to create faxes
8



! CallPilot Player to play and record voice messages. An embedded version of the 
CallPilot Player (shown in this guide) may appear in your Inbox and voice 
messages. (For required settings, see Setting messaging preferences, on page 
32.) Some Windows-based systems and all Macintosh systems will not display the 
embedded player. If not, you will be prompted to download the CallPilot Player. If 
you are on a Windows-based platform and are only playing messages, not 
recording, you can use the Microsoft Windows Media Player, or another WAV-
compatible media player. These players will not function exactly the same as the 
CallPilot Player described in this guide. 

! A LAN (Ethernet), ISDN, ADSL, or dial-up modem connection to the CallPilot 
server for accessing CallPilot messages

To download audio players
You need an audio player to play and record voice messages. The first time you log in to 
My CallPilot, it checks to see that an audio player is installed. If one is not installed, you 
will be prompted to download the CallPilot Player. Follow the instructions to start the 
download and installation process. If you need to re-install a player at a later time:

1 Click Downloads on the CallPilot Features main page. 
2 Select the CallPilot Player or other audio player from the list. The various 

downloadable players are shown below.

                The Windows downloadable CallPilot player

The Macintosh downloadable CallPilot player with QuickTime 4.0

The Macintosh downloadable CallPilot player with QuickTime 5.0
9



Logging in

Your administrator provides you with the URL for My CallPilot. Bookmark this address 
in your web browser for easy access.

To log in to My CallPilot
1 In your web browser, navigate to the My CallPilot address.

2 On the Welcome page, in Mailbox, type your mailbox number. This is usually 
your office telephone extension number.

3 In Password, type your CallPilot password.
4 Click Login.

To change to another server
If you have a mailbox on another CallPilot server, you can log in to that server from My 
CallPilot. Click Configure, type the server details, then click OK. When you log in again 
from the same computer, CallPilot accesses the new server. To change back to your 
default server, click Configure, then click Restore Default.

To change to another language
If language buttons are available on your My CallPilot login page, you can click one to 
change from your default language to another language.

To log in using secure login
If the Enable Secure Login link is available on your login page, click it to enable SSL 
encryption. The Login Securely button appears. Bookmark the link for future logins.

To log in remotely
You can log in to My CallPilot from any computer that has Internet access and 
supported browser configuration. You can use the pre-installed audio player for voice 
messages, or you can download the CallPilot Player for full feature capability.

To log out
To log out from My CallPilot, click Logout on any My CallPilot page.

Do not check the 
Remember 
Password box on a 
shared computer.

The Login Securely 
link appears if SSL 
encryption is 
enabled.
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CallPilot Messages tab

To access your CallPilot messages, click the CallPilot Messages tab. You can access 
voice messages and view faxes, delete, forward, and reply to messages, and 
compose new messages.

Your Message List

To check for new messages
To see new messages, click Refresh. New messages appear in Bold.

To open a message
To open a CallPilot message, click the voice, fax, or text icon in the Attachments column 
beside the message, or click any underlined part of the message line. See Playing 
voice messages, on page 12, and Viewing fax messages, on page 14.

To select a message 
To select a CallPilot message, check the box at the far left of the message line. When a 
message is selected, you can delete, forward, or reply to it.

To delete a message
To delete a CallPilot message, select it and click Delete or Delete Now. If you click 
Delete, the message is permanently deleted when you log out. If you click Delete 
Now, all selected messages are permanently deleted immediately.

To select your telephone or computer to play and record voice messages
You can choose to play and record voice messages through your telephone or your 
computer. Click the Telephone or Computer icon in the embedded or downloaded 
CallPilot Player. (To record and play messages using the telephone, you must have a 
properly configured firewall, or no firewall between you and the web server.) 

See Setting messaging preferences, on page 32, to change the audio setting and the 
number that CallPilot dials for playing and recording messages.

Use the 
embedded 
CallPilot 
Player, if 
available, to 
play and 
record voice 
messages

Messages tab

Urgent
Private

Attachments:
Voice

Fax
Text
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Playing voice messages

Before playing voice messages, see To select your telephone or computer to play and 
record voice messages, on page 11.

To play a voice message the quick way (Windows only)
Use the embedded CallPilot Player, if available, to play your voice messages quickly. 
(The player appears in your Message List if the Attachments column appears, and if you 
select VBK as your audio setting. See Setting messaging preferences, on page 32. 
Note that the player can also play WAV format audio files.) 

1 In your Message List, click the Voice (Play) icon in the Attachments column. 
When the audio controller window appears (Windows version shown below), 
press the Play button if playing does not start automatically.

2 If you selected Computer for playback, the audio player plays your message 
from your computer’s speakers.
If you selected Telephone for playback, your telephone rings and plays the 
message when you answer.

3 Use the player buttons to stop, re-play, or call the sender. Other controls on the 
player also permit absolute positioning within a recording, volume level 
adjustment, and altering the play rate (speed).

4 Click Disconnect, or hang up the telephone when you are finished.

To play a voice message in a mixed voice, fax, or text message
In a mixed voice, fax, or text message, open the message to select each part.

1 In your Message List, click any underlined part of the message to open it.
2 In the open message, click the Voice icon. The audio player opens.
3 If you selected Computer for playback, the audio player plays your message 

from your computer’s speakers.
If you selected Telephone for playback, your telephone rings and plays the 
message when you answer.

4 Use the player buttons to stop/pause, re-play, or call the sender (Windows only). 
Other controls on the player also permit absolute positioning within a recording, 
volume level adjustment, altering the play rate (speed), and disconnecting 
(hanging up). 

Note: On the Macintosh CallPilot Player, there is no Stop button. When you click the 
Play button, play begins and the Play button then becomes the Pause button. In 
addition, the audio control commands can be accessed via the Audio menu of the 
Macintosh CallPilot Player.

Play messages 
from computer 
or telephone

Play/Re-play      Stop           Disconnect      Call Sender

Embedded Windows 
CallPilot Player

Controls on other audio 
players vary
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5 Click the Disconnect (Windows) or Hang Up (Mac) button, or hang up the 
telephone when you are finished. Click Message List to return to your messages.

Return to
messages

Reply to,
forward,  or
delete this
message
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Viewing fax messages

To view faxes on your computer, you must have ImageMaker or other imaging software 
installed on your Windows-based computer. For Macintosh users, the CallPilot Player 
application is used to view faxes. In addition, your CallPilot administrator must enable 
fax capability for your mailbox in order for you to receive faxes.

To view a fax message 
1 In your Message List, click the fax icon beside the message, or click any 

underlined part of the message that you want to view. 

2 The image may display right away, or if the Open/Save dialog appears, select 
Open to display the image. The fax can then be scaled to its normal (printed 
page) size, to an enlarged view that still fits on typical displays, to a maximum 
size where every pixel is visible, or to a view where a fax page is made to fit the 
current window size. The fax document may also be rotated to 90, 180, or 270 
(-90) degrees.

3 When you have finished, close the fax image to return to your messages.

Note: If you are using Windows imaging software other than ImageMaker or if you are 
working on a Macintosh, the appearance of the fax message may differ from the one 
shown. In addition, some of the controls seen here, such as Zoom in and Zoom out, 
may not be available. 

Print Change 
page

Rotate

Fit width

Zoom in/out
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In the Macintosh CallPilot Player, the control commands are accessed via the Fax 
menu.
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Composing voice messages

You can compose a message that is any combination of voice, fax, or text. To record 
voice messages, use the embedded or the downloaded CallPilot Player. 

Note: Your system administrator may have My CallPilot Voice Blocking enabled. If 
enabled, My CallPilot users will not be able to save a voice message to their local PC 
or forward voice messages to non-CallPilot addresses. However, you will still be able 
to forward voice messages to addresses in CallPilot format.

To record and send a new voice message 
1 In your Message List, click Compose. A new message page opens.
2 Click To… (or Address Book) to address from the CallPilot Address Book, or click 

Special Addresses. See Addressing messages, on page 23.
3 Add a subject description in the Subject field.
4 In the embedded or downloaded Windows CallPilot Player, select the Telephone 

or Computer icon. If you are using a Macintosh, select either Use Telephone or 
Use Macintosh from the CallPilot Player’s Audio menu.

5 Click the Record button.
Note:  You can only record into a new audio window, not to audio files that exist 
in your inbox.

Use 
telephone 
or computer 
icon to 
record 

Start new 
voice 
recording

Save voice 
recording 
and attach 
it  to this 
message

Disconnect 
after 
recording

Play/Review   Stop   Record   Playback sliderInterface showing Embedded Player
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Note: On the Macintosh CallPilot Player window (QuickTime version 5.0 shown 
below), there is no Stop button.

When you click the Record button, recording begins and the Record button then 
becomes the Pause button.

6 ! If you are recording from the computer, record your message into the 
microphone. Click Pause to pause the recording. Click Stop to end the 
recording. Click Play to review it. To add to the recording, click Record, speak 
again, then click Stop. Click Save Audio. 
! If you are recording from the telephone, answer when it rings. At the tone, 
record your message into the handset. Click Pause to pause the recording. Click 
Stop to end the recording. Click Play to review it. To add to the recording or re-
record it, move the playback slider to the desired position, click Record, speak 
again, then click Stop. Click Save Audio. Hang up.

Note:  Saving your audio works a little differently depending on which version of 
the CallPilot player you are using. If you are using the embedded version, the 
Save Audio button will only save the message as an attachment to the current 
message. If you are using the downloaded (standalone) version, you save the 
recording as a file, which you then attach to your message. 

7 If you are using the standalone version of the Player,add your voice message file 
as an attachment and set options if required. See Adding attachments to 
messages, on page 21, and Setting message options, on page 22.

8 Click Send.

To save a newly-created voice message as a file
If you have a requirement to save a copy of your voice recording as a standalone file 
you must use the standalone CallPilot player, not the embedded Player.

1 Open the CallPilot Player, record a new message, and on the File menu, click 
Save Audio.

2 In the File name box, type a name for the file, select a folder to keep the file in, 
then click Save. Save voice files as .vbk files. 
Note: My CallPilot automatically converts .vbk files to .wav files when sending to 
non-CallPilot users.
17
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Composing fax and text messages

Your CallPilot recipients must have fax capability to view your fax on their computer. If 
your recipients access their messages from their telephone, they can view the fax only 
by printing it. You can also send your fax to a fax machine.

To create and save a fax file
To create a fax file, your CallPilot mailbox must have fax capability, and your computer 
must have Desktop Messaging installed. After you save the fax file, you can add it to a 
message as an attachment.

1 Launch the application you want to use to create a fax with. The document you 
open or create must be 8.5 in. (21.5 cm) wide or less. Multiple page documents 
are allowed.

2 When the document is ready:
! Windows computer: 

a. Click Print or Print Setup under the File menu.
b. From the list of printers, select Nortel Fax.

! Mac computer:
a. First select the Chooser desk accessory from the Apple Menu
b. Then select the CallPilot Fax icon and close the window. 

3 Click Print and then OK.

4 In the Compose Fax dialog box, click Save As. 

Compose Fax dialog box - Windows version.

View before 
sending

Delete before
sending

Change orde
of files to be 
faxed

File name

Send fax

Save to send
later
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Compose Fax dialog box - Macintosh version.

5 Type a name for the file, and browse to select a folder to save it in. Save the file 
as a TIF file. Click Save.
Note:   If you chose to include a Subject line here, the information in that field will 
only be displayed in the e-mail portion of the fax. It will not be displayed on a hard 
copy of the fax.

6 Click Exit to close Compose Fax.

To compose and send a fax or text message
1 In your Message List, click Compose. A new message page opens.

2 Click To… (or Address Book) to address from the CallPilot Address Book, or 
click Special Addresses. See Addressing messages, on page 23.

3 Add a fax file as an attachment. See Adding attachments to messages, on page 
21.

4 Add options if required. See Setting message options, on page 22. 
5 Enter text if required.
6 Click Send.

Calling the sender of a message

You can respond to a voice message with a telephone call instead of a recorded 
message. 

1 In an open message, click Call Sender .

2 Answer the telephone when it rings. CallPilot immediately calls the sender of the 
message.

3 When you have finished the call, hang up the telephone or click Disconnect .
19



Forwarding and replying to messages

You can forward a message, and compose an introduction to send with it. You can also 
compose a reply to the sender of a message, or to the sender and all recipients of a 
message.

To forward or reply to a message
1 In an open message, click Forward, Reply, or Reply to All.

2 On the new message page, compose a voice, fax, or text message. 
3 Address forwarded messages the same way as a new message. Replies are 

addressed automatically.
4 Add attachments, set options, and change the Subject line if required.
5 Click Send.

Attach fileType text message
20



Adding attachments to messages

Before sending a message, you can attach a voice, fax, or text file to it. Voice files can 
be either VBK or WAV format for both Windows and Mac CallPilot recipients. My 
CallPilot automatically converts VBK files to WAV files when sending to non-CallPilot 
users. Fax files must be TIF format. Text files must be TXT format. 

To attach a file to a message
1 On a new message page, click Attach Files... .
2 In Add Attachments, browse for and select the file that you want to attach. 

3 Click Open.
4 Click Attach for the selected file.
5 Click OK. The icon for the attached file appears beside the Attach Files button 

on the new message.  
6 Continue to compose, address, and send the message as usual.
21



Setting message options

Before sending a message, you can set options for handling and delivery.

To set message options
1 On a new message page, select Delivery, Sensitivity, and Receipt options, as 

required.

! For Priority, select Urgent, or leave the setting as Normal.
! For Sensitivity, select Private, or leave the setting as Public. 

You cannot forward messages that are marked Private to other CallPilot users. 
However, be aware that when you send a message marked Private, your recipient 
may still forward it to someone else, if they are not a CallPilot user. Also, recipients in 
non-CallPilot systems will not be informed of Private settings. In your message, tell 
the recipient that the message is Private.

! For Notify me..., check the box to request acknowledgment that your recipient 
received the message.

2 Continue to compose, address, and send the message as usual.
22



Addressing messages

You can address a CallPilot message in two ways: 

! You can select a name from the CallPilot Address Book that is maintained by your 
organization on the server. It contains the addresses of the CallPilot users and 
shared distribution lists that you can use. You cannot edit this list.

! You can manually enter or select addresses on other servers in Special 
Addresses.

To address a message from the Address Book 
1 In a new CallPilot message, click To: (or Address Book).

2 In Enter last name, type the recipient’s name, then click Find.
3 In the list of names, select the name of the recipient or distribution list.
4 Click To. You can select one or more addresses, clicking To after each one.

5 Click OK to return to the new CallPilot message.

To address in Special Addresses
1 On a new message page, click Special Addresses.
2 Select an address format from the drop-down list (for example Network mailbox).

3 Type the number and any other information required. Refer to the online Help for 
the correct addressing formats.

4 Click To.
23



CallPilot Features tab
Click the CallPilot Features tab to change the settings for your CallPilot features and 
telephone options, and to set preferences for web-based access.

The main CallPilot Features page displays only the features that are available for you to 
use. Click any title to open its settings page. 
24



Setting up message notification
CallPilot can notify you of new messages when you are away from the office. Your 
administrator defines whether these devices and services are available to you:

! Remote text notification to a wireless e-mail device. See Appendix A: Remote 
Text Notification, on page 38.

! Remote Notification to a telephone or pager. This type of remote notification can 
be set up and turned on or off from your telephone as well. You can set up two 
time periods for notification, and choose whether you want to be notified of all 
messages or urgent messages only.

You can have the two types of notification turned on simultaneously.
25



Managing personal distribution lists

A distribution list saves you time when you send messages to the same group of 
addresses. You can create up to 99 personal distribution lists, and enter a number and 
name to identify each list. Each personal distribution list can contain up to 200 entries. 

A personal distribution list can contain all of the same types of addresses to which you 
can send a composed message, except other personal distribution lists. An entry can 
be a mailbox number, shared distribution list number, network mailbox, open network 
mailbox, or telephone number.  

You can create personal distribution lists in My CallPilot or on your telephone. These 
lists are stored for you in the CallPilot Address Book on the CallPilot server. You can 
access these lists from My CallPilot, Desktop Messaging, and your telephone.

To edit, delete, or create personal distribution lists
To edit or delete an existing list, select the list and click Edit or Delete. Make the 
changes, then click Save.

To create a personal distribution list, click Add New List. Type a number and name for 
the list. Add entries by selecting an address format from the drop-down list, then enter 
the information required. Refer to the online Help for the correct addressing formats, if 
required. Click Save.
26



Changing your CallPilot password

This is the same password that you use to log in to CallPilot from the telephone. 
CallPilot requires that you change your password on a regular schedule set by your 
administrator.

CallPilot prevents you from using some passwords if they are too short or too simple, or 
if you have used the same one recently. Keep your mailbox secure by choosing 
passwords that are not easily discovered. 

To change your password, type your old password, type your new password twice, then 
click Save. 
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Changing your telephone options

To assign a custom operator number for callers
You can offer your callers the option of leaving a message or speaking to one of your 
assistants or colleagues. In your greeting, tell callers to press zero if they wish to speak 
to this person in your absence. The custom operator number is the number your callers 
reach when they press zero. Enter the number in Telephone Options.

To set times and options for blocking messages from callers
You can temporarily prevent your callers from leaving messages in your mailbox. You 
can choose to transfer callers to your custom operator, or disconnect them. As a 
courtesy to your callers while message blocking is turned on, you should record a 
temporary greeting that provides details of your absence and tells callers what to do. 
Select the settings in Telephone Options.

To turn Autologin on or off and define allowed numbers
When Autologin is turned on, you do not have to enter your mailbox and password when 
you log in from a defined number. Your administrator defines secure numbers for 
Autologin, such as your office or home telephone. When Autologin is turned on, you 
access your mailbox by dialing the CallPilot access number or pressing the message 
key at one of your defined Autologin numbers. To turn on Autologin, check the box in 
Telephone Options. 
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Setting up telephone access to e-mail

To set up access to your e-mail accounts from CallPilot, see Setting up links to your e-
mail accounts, on page 31. You can specify one of these e-mail accounts for telephone 
access so that you can check for new e-mail messages while logged in to CallPilot from 
your telephone. You can have the text content of any new e-mail messages read to you 
over the telephone.

To set up an e-mail account for telephone access
1 Open the E-mail By Phone page. Your e-mail account links are displayed.

! To set up or edit a mailbox link, click Configure New Mailbox Link. 
See To set up an e-mail link, on page 31.

2 Select one e-mail account for access by telephone.
3 Select a female or male voice to read your e-mails.
4 Click OK.
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Changing fax printing options

If your CallPilot mailbox has fax messaging capability, you can receive a fax message in 
your mailbox and print the fax at a selected fax number. Set options for default fax 
number, Autoprinting, and print cover page on the Fax Printing page.

To change the default printer
You must set a default fax number if you turn Autoprinting on. Even if you are not using 
Autoprinting, a default fax number is the simplest way to print. The default number can 
be any fax number that CallPilot can dial, including any normally required prefixes. 

To turn Autoprinting on or off
When Autoprinting is turned on, any faxes that arrive at your mailbox are automatically 
printed at a specified default fax number. A message that has been autoprinted remains
in your mailbox so that you can reprint it or forward it. Your printed faxes may be 
automatically deleted from your mailbox on a schedule set by your administrator.

Autoprinting is the most convenient way to handle fax messages while you are in one 
location. If you are away from your office, you can turn Autoprinting off and print your 
faxes at another fax number. 

To turn fax separator page printing on or off
You can select whether to print a fax separator page when you print a fax message. A 
separator page identifies you and gives details of the print job, such as the number of 
pages. Separator pages are useful if you receive faxes without cover pages. If the 
sender of the fax includes a header page with the fax, the header page also prints.
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Setting up links to your e-mail accounts

You can set up links in CallPilot so that you can check your e-mail for new messages. 
You may also be able to forward and reply to messages, and send new e-mails.

You can define up to five e-mail accounts. One of these accounts can be set up for 
access from your telephone. See Setting up telephone access to e-mail, on page 29. 
The selected account shows a check mark under Enabled for E-Mail By Phone.

To set up an e-mail link
1 On the Mailbox Links page, click Configure New Mailbox Link.
2 Select your e-mail server from the drop-down list. To get this name, look in the 

account settings of your e-mail application, or ask your administrator.
3 Type a name for this account to display on the tab.
4 Type the name of the folder to access for your e-mail messages, such as Inbox.

5 Type your e-mail address. 
6 Type your mailbox user name (the User ID of your e-mail account).
7 Type the password for this e-mail account.

8 Click OK. The password is encrypted for security.
You can edit this information at any time, or delete the account.

Remember that whenever you change your e-mail password, you need to change it in 
My CallPilot as well.
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Setting messaging preferences

To change Message List columns
You can change the columns in your Message List. “Attachments” must be in the 
Displayed Columns list to see the embedded Player (Windows only) in your Message 
List. 

To add a signature
Type or paste your signature and other information, then click the check box if you want 
this signature added automatically to outgoing text messages.

To change environment settings
Change any of these My CallPilot settings to your preferences.

This is usually your own 
extension. Keep the 
telephone within easy 
reach of your computer.

Select CallPilot (VBK) 
if you want to use the 
embedded CallPilot 
Player (allows Call 
Sender and Disconnect).
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Note: The Remove Deletable items on Logout checkbox applies to both regular 
e-mail messages as well as messages you access when using E-mail-by-Phone. 
This checkbox must be selected to enable the removal of messages that you have 
deleted when you logout.

Macintosh Preferences window
The Preferences option under the Edit menu allows the following user settings to be 
saved for the CallPilot Player application on the Macintosh.

The defaults are: Macintosh audio device, all settings checked.

Note: It is possible that you may see the Audio Device section "grayed out".  This 
happens if the Mailbox class is set to restrict the user to use a specific device 
(telephone or PC/Mac).
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Choosing a home page for My CallPilot

Choose the page that you want to automatically display when you log in to My CallPilot.
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E-mail tab

While you are logged in to My CallPilot, you can check your e-mail messages. You may 
also be able to forward and reply, and send new e-mails. See Setting up links to your 
e-mail accounts, on page 31. 
Note: to access e-mail from My CallPilot, the TLS field for the external e-mail server 
must be set to “0”, unless it supports SSL IMAP connections.

You can access up to five IMAP e-mail accounts, or other CallPilot mailboxes. One of 
these accounts can be set up for access from your telephone. See Setting up 
telephone access to e-mail, on page 29. 

You can also set up access to a second CallPilot mailbox, which may be on another 
server. For setup details, refer to the online Help. 

Each E-mail tab shows the name of the account associated with that tab.

To open a message
To open an e-mail message in My CallPilot, click the icon in the Attachments column 
beside the message, or click any underlined part of the message line.

To delete a message
To mark an e-mail message for deletion, select it and click Delete. To ensure that 
deleted messages are permanently deleted, open the Messaging Preferences page, 
and in Environment Settings, check the Empty Trash at logout box.

To compose and send a new message
To compose a new e-mail message, click Compose, type the message, and send it the 
same way as a CallPilot message. The address book is not available.

To forward and reply to messages
You can forward and reply to e-mails in the same way as CallPilot messages, except 
that the address book is not available.
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Useful Information tab

Click the Useful Information tab to:  

! View status and details about your mailbox.
! View online user guides.
! Print online user guide files on your laser printer.
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Protecting the security of your mailbox

Because My CallPilot is a web-based product, it is important to take precautions to 
protect the security of your mailbox.

! If your administrator has enabled SSL encryption, you can use the Secure Login 
feature for greater security. See To log in using secure login, on page 10.

! When you have finished using My CallPilot, make sure that you log out. If you go 
to a web site outside of My CallPilot without logging out, CallPilot does not log out 
immediately. This can make your CallPilot information vulnerable to hackers. If 
you want to visit a web site without exiting My CallPilot, use a separate browser 
window to view the other site.

! You can set CallPilot to log out automatically after a short time, such as 5 or 10 
minutes. See Setting messaging preferences, on page 32.

! If you are using a public or shared workstation, avoid using the Remember 
Password option when you log in to My CallPilot. If this option is selected, others 
can access your CallPilot mailbox.

! If you are using a public or shared workstation, you should empty the browser 
cache after a CallPilot session. For information about your browser cache, see 
your browser online Help.
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Appendix A: Remote Text Notification

Remote text notification can be configured to send a message to your SMTP e-mail 
account when a new voice, fax, or text message arrives in your CallPilot mailbox. You 
can setup notification to any e-mail server that supports SMTP.  These include most 
e-mail accounts, wireless handheld organizers, mobile phones, or PDAs like the 
Research In Motion Blackberry.

To set up My CallPilot for remote telephone or pager notification, see Setting up 
message notification, on page 25.

This section describes how to set up remote text notification for Microsoft Outlook and 
BlackBerry devices. Any device or portal with a service provider that supports SMTP 
can receive e-mail notification messages. If you plan to use another type of device to 
receive remote text notification, ask your CallPilot administrator about any additional 
setup that may be required for your device.

To receive notification messages on a Research In Motion (RIM) BlackBerry Internet 
Edition device, you must configure Microsoft Outlook and BlackBerry Desktop Manager 
(version 2 or later) to forward CallPilot notification messages to your BlackBerry device. 

If you use a BlackBerry Enterprise Edition device, your administrator can set up 
notification message forwarding for you on the e-mail server or configure BlackBerry 
Desktop Manager to redirect CallPilot notification messages.

Note: If you set up My CallPilot to send CallPilot notification to your Outlook Inbox, 
and set up BlackBerry Desktop Manager to send all incoming messages to your 
Blackberry device, your CallPilot notification messages will appear in your list of e-
mails on your Blackberry device with no additional configuration required.

Notification message format
An e-mail notification message can show the 

! type of message

! name of the person who left the message, if available
! telephone number, if available

For example, John Smith calls from extension 1234 and leaves a voice message for 
Andrew Jones. An e-mail message is sent to Andrew Jones with the following text:

You have a voice message from John Smith [1234]

Microsoft Outlook forwards this e-mail message to Andrew’s BlackBerry device. The 
message appears with the subject CallPilot Notification. Once Andrew receives the 
message, he can decide whether to retrieve the message from CallPilot or to call John 
immediately, using a telephone.
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Getting started

Requirements
! You need a BlackBerry device. Ensure that e-mail service on your BlackBerry 

device is working. 
! Microsoft Outlook must be installed. Currently, BlackBerry Desktop Manager only 

works with Microsoft Outlook. Consult your BlackBerry documentation for 
information about other e-mail clients.

! BlackBerry Desktop Manager 2 or later must be installed and running on your 
computer.

! Remote text notification capability must be enabled and set up for your mailbox 
by your CallPilot administrator.

! Remote text notification must be configured and enabled in My CallPilot. For 
more information, see Setting up message notification, on page 25.

Configuration steps
Complete the following steps to effectively manage e-mail notification messages.

Step Reference

Create a holding folder for your e-mail 
notification messages so that they are stored 
separately from your other messages.

If you want to forward all messages in your 
Outlook inbox to your BlackBerry device, you 
can skip this step.

“Creating a notification holding folder” 
on page 40

Configure BlackBerry Desktop Manager to 
forward messages to your BlackBerry device. 

“Configuring BlackBerry Desktop 
Manager” on page 43

If desired, configure Outlook to automatically 
delete old CallPilot notification messages from 
the holding folder.

Alternatively, you can manually delete 
notification messages from the holding folder.

“Automatically removing notification 
messages” on page 44
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Creating a notification holding folder

You can create a holding folder for your CallPilot e-mail notification messages so that 
they are stored separately from your other messages. To store messages in the folder, 
follow these steps:

1 Create an Outlook folder for the notification messages.
2 Configure Outlook to route CallPilot notification e-mail messages to the folder 

using the Rules Wizard.

To create a notification folder
1 Start Outlook.

2 In the Folder List, select Outlook Today.
3 From the File menu, choose New > Folder. The Create New Folder dialog box 

appears.
4 In the Name box, type CallPilot Notification, and then click OK. The CallPilot 

Notifications folder appears in the Folder List. 

To route notification messages to the holding folder
1 Choose Tools > Rules Wizard. The Rules Wizard dialog box appears.
2 Click New. The first panel of the Rules Wizard appears.
3 In the list of rule types, select Check messages when they arrive, and then click 

Next.
4 In the list of rule conditions, check With specific words in the subject box.
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5 In the Rule description box, click specific words. The Search Text dialog box 
appears.

6 In the Add new box, type CallPilot Notification.
7 Click Add. The text “CallPilot Notification” is added to the Search list box.

8 Click OK. The search text “CallPilot Notification” appears in the rule description.

9 Click Next.

10 In the list of actions, check the “move it to the specified folder” box.
11 In the Rule description box, click “specified”. A list of Outlook folders appears.
12 In the folder list, choose CallPilot Notifications, and then click OK. The folder 

name appears in the rule description.
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13 Click Finish. The finished rule is shown below:

14 Click OK to close the Rules Wizard.



Configuring BlackBerry Desktop Manager

This section explains how to configure BlackBerry Desktop Manager to redirect your 
e-mail notification messages.

If you did not create a holding folder for notification messages, and if you already 
configured BlackBerry Desktop Manager to forward messages in your Outlook Inbox, 
you can skip this section.

To configure e-mail redirection
1 From the Windows Start menu, choose Programs > BlackBerry > 

Desktop Manager. BlackBerry Desktop Manager appears.

2 In the application list, double-click Redirector Settings. The Redirector Settings 
dialog box appears.

3 Click the Advanced tab.

4 In the Folder redirection section, choose Selected folders.

5 Click Choose Folders… . The Choose Folders dialog box appears.
6 Select the folders where you receive messages that you want to redirect to your 

BlackBerry device.
! To redirect messages in your holding folder, select the CallPilot Notification 

folder.
! To redirect all messages in your Outlook Inbox, select the Inbox folder.
7 Click Save to save your folder selection.

8 Click OK to save your redirection options.
9 Exit BlackBerry Desktop Manager. 
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Automatically removing notification messages

This section explains how to configure Outlook to automatically remove messages from 
the CallPilot Notifications holding folder using the AutoArchive feature. If you do not 
want Outlook to automatically delete notification messages, you can manually delete 
them from the folder.

You must perform two steps to configure automatic deletion of notification messages:

1 Set up AutoArchive to delete messages from the CallPilot Notifications folder.
2 Activate the AutoArchive feature.

To set up deletion of notification messages
1 In the Outlook folder list, right-click the CallPilot Notifications folder, and then 

choose Properties. The CallPilot Notification Properties dialog box appears.

2 Click the AutoArchive tab. 

ATTENTION
If you currently do not use AutoArchive, ensure that you become 
familiar with this feature before you activate it. You may have 
existing folders with AutoArchive settings that have never been 

activated. If you activate AutoArchive to automatically delete 
messages from the CallPilot Notifications folder, you may find that 
messages in other folders are being archived as well.

If you are unsure about what to do, check with your local Microsoft 
Outlook support group.
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3 Select the “Clean out items older than” check box. 
4 Set the time to 1 day. 
5 Select Permanently delete old items. 

6 Click OK.

To activate AutoArchive
1 In Outlook, choose Tools > Options. 

2 Click the Other tab.
3 Click AutoArchive. The AutoArchive dialog box appears.

4 Check the AutoArchive every… box and set the frequency to 1 day.
5 Click OK to close the dialog box.
6 Click OK to close the Options dialog box. 
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